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Введение

Сегодня трудно кого-нибудь удивить книгой по «компьютерной тематике». И это понятно, так как человечество уже не может существовать без компьютера. Тем не менее, существуют такие сферы человеческой деятельности и такие программные продукты, которые совершенно незаслуженно обделены вниманием и авторов, и книгоиздателей. Речь идет о человеке-операторе, контролирующем и управляющем какими-либо техническими процессами на производстве, в коммунальном хозяйстве, на транспорте и, соответственно, о программном обеспечении, предназначенном для создания интерфейса между оператором и контролируемым процессом.
Существует множество программно-аппаратных комплексов, но в данной пособие рассматривается SIMATIC S7, разработанный корпорацией Siemens. Сообщество людей во всем мире, использующих этот продукт в своей повседневной деятельности.
Это учебное пособие предназначено, в первую очередь, для читателя, который имеет возможность и желание изучить программно-аппаратных комплекс SIMATIC S7 либо под руководством преподавателя, либо самостоятельно, но обязательно путем кропотливой практической работы.
Необходимо подчеркнуть, что предлагаемое пособие нельзя рассматривать как некоторое дополнение к разнообразной документации по SIMATIC S7. Основная цель данного пособия: дать возможность читателю получить представление об SIMATIC S7 как о некотором целостном механизме для решения задач операторского взаимодействия с технологическим процессом с помощью его графического представления. Поэтому задания составлены таким образом, чтобы в итоге получилось некоторое работоспособное учебное приложение, предназначенное для изучения разнообразных возможностей SIMATIC S7 на примере конкретного технологического процесса.


ЛАБОРАТОРНАЯ РАБОТА №1. Лабораторная установка на базе комплекса технических средств и системы управления фирмы «SIEMENS».

Цель работы: Ознакомиться с технической, аппаратной и программной оснащенностью лабораторной установки.

[bookmark: _Toc455927627]Содержание работы:
1. Ознакомиться с перечнем технологического оборудования лабораторной установки.
2. Ознакомиться с комплексом технических средств (датчиков, исполнительных механизмов и т.д.), модульной конструкцией системы управления на базе контроллера SIMATIC S7-400, перечнем и типами входных/выходных сигналов. 
3. Ознакомиться с программными компонентами и модулями среды разработки SIMATIC PCS 7.
4. Подготовить ответы на контрольные вопросы.
5. Подготовить отчет.

[bookmark: _Toc455927628]Перечень технологического оборудования лабораторной установки.
В качестве объекта автоматизации выступает колонна насадочного типа, куб которой оснащен трубчатым электронагревателем (ТЭНом) мощностью 6 кВт (рис. 1). Технологическое оборудование включает в себя: выносной кипятильник, дефлегматор и флегмовую ёмкость. Полевое оборудование монтируется на установке по месту.
Исходная смесь поступает в колонну 10 по линии подачи питания 2 через запорную арматуру 1. Внутри установки жидкость, двигаясь сквозь слои насадки, достигает куба, в котором установлен ТЭН 19, предназначенный для поддержания оптимального уровня путем  испарения накапливающейся жидкости.	Comment by SVizor: Исправлено.
При необходимости в работу включается выносной кипятильник 13, оснащенный ТЭНом мощностью 2 кВт. Полученный пар, поднимаясь вверх по колонне и проходя сквозь насадочные слои, поступает в дефлегматор 11, откуда, сконденсировавшись, попадает во флегмовую ёмкость 12. Подача флегмы на орошение колонны осуществляется посредством насоса 7 через регулирующий клапан 16.

Рис. 1. Принципиальная схема установки.

[bookmark: _Toc455927629]Комплекс технических средств.
Среди параметров процесса, которые подлежат контролю и управлению, можно выделить следующие: 
· температурный профиль по высоте колонны; 
· давление верха и уровень в кубе колонны; 
· перепад давления по высоте колонны; 
· температура и уровень во флегмовой ёмкости; 
· расход хладагента в дефлегматор
· расход флегмы в колонну. 
Для измерения вышеуказанных величин используется комплекс технических средств со следующими характеристиками:
· Термометр сопротивления ТСМУ Метран-274. Выходной сигнал: 4-20 мА. Диапазон измерений: 0…180 ºС. Используется для измерения  температурного профиля по высоте колонны. 
· Термопреобразователь SITRANS TH400 PA. Выходной сигнал: цифровой сигнал PROFIBUS PA. Диапазон преобразуемых температур: 0…100 ºС. Применяется для измерения температуры жидкости во флегмовой емкости. 
· Датчик избыточного давления SITRANS P DS III.  Выходной сигнал: цифровой сигнал PROFIBUS PA. Максимально допустимый предел  измерения: 16 бар. Используется для контроля давления верха колонны. 
· Датчик разности давления SITRANS P250. Выходной  сигнал: 4-20 мА.  Интервал измерения: 0…0.6 бар. Используется  для измерения уровня в кубе колонны. 
· Датчик разности давления Метран-100-ДД. Выходной  сигнал: 4-20 мА. Верхний  предел измерения: 10 кПа. Применяется для измерения перепада давления по высоте колонны, уровней в кипятильнике и во флегмовой ёмкости. 
· Кориолисовый массовый расходомер SITRANS F C MASSFLO MASS 6000. Выходной сигнал: цифровой сигнал PROFIBUS PA. Максимальное значение расхода: 5600 кг/ч.  Используется  для измерения расхода флегмы в колонну. 
· Электромагнитный преобразователь расхода ПРЭМ-3.  Выходной  сигнал: 4-20 мА. Максимальное  значение  расхода: 12 м/ч. Используется для измерения расхода расход хладагента в дефлегматор. 
· В  качестве исполнительных механизмов  в  одноконтурных  системах регулирования расхода применяются электроприводы  МЭОФ с электрическим пускателем ПБР-2М и блоком сигнализации положения БСПТ. Электрическое питание: 220V 50 Hz. 

[bookmark: _Toc455927630]Архитектура системы управления SIMATIC PCS 7.
Система автоматизации объекта построена на базе распределенной системы управления SIMATIC PCS 7 фирмы SIEMENS. Она предоставляет широкий выбор аппаратных средств, программного обеспечения, инструментов разработки, конфигурирования и диагностики для автоматизации промышленных процессов и управления. Типовая конфигурация системы представлена на рис. 2.
ES означает Engineering Station (инженерная станция), OS – Operator Station (операторская станция), а AS – Automation Station (станция автоматизации - контроллер). 
Станция автоматизации, в общем случае может состоять из следующих модулей:
· источника питания (PS – Power Supply),
· центрального процессора (CPU – Central Processing Unit), 
· коммуникационного процессора для процессной шины (CP для Ethernet) (необязательно),
· коммуникационного процессора для полевой шины (CP для PROFIBUS DP) (необязательно),
· модулей входов и выходов (необязательно).

Рис. 2. Типовая конфигурация PCS 7.

[bookmark: _Toc455927631]Аппаратная платформа.
Аппаратная платформа реализована на базе контроллера SIMATIC S7-400 фирмы SIEMENS и включает в себя следующие основные компоненты: 
· Блок (корзину) контроллера, состоящий  из блока питания PS 407, модуля центрального процессора CPU 414-3 и коммуникационного процессора CP 443-1, обеспечивающего возможность подключения ПЛК к сети Industrial Ethernet. 
· Станцию распределенной периферии SIMATIC ET 200M, использующую в своем составе интерфейсный модуль IM 153-2 и целый ряд сигнальный модулей аналогового (SM 331 и SM 332)  и  дискретного (SM 321 и SM 322). 
· Модуль связи DP/PA coupler FDC 157-0, реализующий переход между интерфейсами PROFIBUS DP и PROFIBUS PA, к которому подключены полевые устройства.

[bookmark: _Toc455927632]Программные компоненты SIMATIC PCS 7.
Разработка и модификация проекта ведется на инженерных рабочих станциях, где установлены инженерные утилиты пакета PCS 7 и имеется коммуникационный доступ к станциям автоматизации и операторским станциям. В состав инженерной станции PCS 7 входят следующие мощные инструменты для  проектирования и разработки:	Comment by SVizor: Исправлено
· SIMATIC Manager: используется в процессе создания проекта, его диагностики а так де для проектирования и реализации алгоритмов управления технологическим процессом.
· HW Config: Hardware Configuration – среда для конфигурирования аппаратного обеспечения. 
· NetPro: утилита, позволяющая проектировать коммуникации между компонентами системы управления.
· Сonfiguration Console (консоль конфигурирования): служит для изменения настроек сетевых карт РС.
· Station Configurator (конфигуратор станции или конфигуратор компонент): показывает фактическую конфигурацию РС для системы PCS 7 и позволяет ее изменять (создавать).
· SIMATIC NET: SIMATIC NET – это платформа для конфигурирования сетевых компонент. NetPro, Configuration Console и Station Configurator являются интерфейсами SIMATIC NET.	Comment by SVizor: Исправлено.	Comment by SVizor: Исправлено.
· WinCC: Windows Control Center (Управляющий центр Windows) – отвечает интерфейс за человеко-машинный интерфейс оператора PCS 7 и визуализацию.

[bookmark: _Toc455927633]Контрольные вопросы
1. Что является объектом автоматизации в данном лабораторном комплексе?
2. Перечислите основные технологические параметры процесса, которые подлежат контролю и управлению. Какие технические средства для этого используются?
3. Какие аппаратные компоненты входят в состав системы управления данной лабораторной установкой? Перечислите минимально возможный набор модулей, необходимый для построения системы автоматизации.	Comment by SVizor: Исправлено.	Comment by SVizor: Исправлено.
4. Какие утилиты используются при разработке системы управления на инженерных станциях?	Comment by SVizor: Исправлено.


[bookmark: _Toc455927634]ЛАБОРАТОРНАЯ РАБОТА №2. Создание проекта PCS 7 – первые шаги.

Цель работы: Создать первый проект в среде разработки SIMATIC PCS 7.

[bookmark: _Toc455927635]Содержание работы:
1. Ознакомиться с основным приложением PCS 7 — SIMATIC Manager.
2. Создать собственный мультипроект и отдельный проект в нем.
3. Ознакомиться со структурой и иерархией проекта.
4. Подготовить ответы на контрольные вопросы.
5. Подготовить отчет.

[bookmark: _Toc455927636]SIMATIC Manager.
SIMATIC Manager – это основная программа в пакете SIMATIC PCS 7. Из нее можно получить доступ к другим утилитам, а также производить различные действия (копирование, удаление, перемещение) над объектами процесса (программными блоками, аппаратными модулями, схемами визуализации).	Comment by SVizor: Переместил. Сначала дадим описание.
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Рис. 3. Главное окно SIMATIC Manager.

Существует 2 способа запуска утилиты SIMATIC Manager: из главного меню Windows (Пуск > SIMATIC > SIMATIC Manager), либо с рабочего стола (двойной щелчок ЛКМ на значке SIMATIC Manager). При запуске программы откроется основное окно (рис. 3).	Comment by SVizor: Исправлено.
С помощью пункта File > New… можно создать отдельный проект, библиотеку или мультипроект. Мультипроект может содержать в себе несколько простых проектов и библиотек. Такой подход удобен, например, при создании сложных систем управления группой специалистов.	Comment by SVizor: Исправлено.
При создании проекта в PCS 7 рекомендуется использовать опцию New Project > Wizard. Этот программа-мастер для создания проектов (Wizard). Благодаря ней формируется типовая структура проекта, которая сразу пригодна для начала разработки.	Comment by SVizor: Исправлено.

[image: ]
Рис. 4. Мастер создания нового проекта (Wizard).	Comment by SVizor: Исправлено.

В первую очередь при созидании мультипроекта, необходимо указать тип центрального процессора (рис. 5). Так же следует обратить внимание на тип блока питания и рейки. После этого следует указать количество уровней иерархии и тип операторской станции (рис. 6). В последнем окне указывается каталог хранения проекта и его имя (рис.7).	Comment by SVizor: Fixed
[image: ]
Рис. 5. Окно выбора типа центрального процессора.
[image: ]
Рис. 6. Окно настройки иерархии проекта.

[image: ]
Рис. 7.Окно выбора рабочего каталога проекта.

Опция New Project > Wizard  создаст мультипроект с типовой конфигурацией (рис. 8), которая включает в себя станцию автоматизации (AS), станцию оператора (OS), а так же библиотеку для хранения различных шаблонных алгоритмов и решений.	Comment by SVizor: Исправлено.
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Рис. 8. Типовой проект PCS 7.

При необходимости, проект подобной структуры можно создать без применения программы-мастера, «вручную», воспользовавшись пунктом меню File > New… . В этом случае будет создан пустой проект. Для добавления нужного компонента (AS, OS и т.д.) в систему следует воспользоваться пунктом контекстного меню Insert New Object (ПКМ по имени проекта).	Comment by SVizor: Исправлено.

[bookmark: _Toc455927637]Контрольные вопросы
1. Что такое SIMATIC MANAGER?
2. Каковы его основные функции?
3. Опишите способы создания проекта в среде SIMATIC PCS 7.	Comment by SVizor: Исправлено
4. Опишите состав и структуру типового проекта.	Comment by SVizor: Исправлено.


[bookmark: _Toc455927638]ЛАБОРАТОРНАЯ РАБОТА №3. Конфигурирование аппаратных средств. Корзина контроллера.

Цель работы: Сконфигурировать в среде разработки SIMATIC PCS 7 модули, входящие в состав корзины контроллера и распределенной периферии.

[bookmark: _Toc455927639]Содержание работы:
1. Ознакомиться с утилитой HW Config.
2. Сконфигурировать модули, входящих в состав корзины контроллера.
3. Сконфигурировать интерфейсные и сигнальные модули, входящие в состав распределенной периферии.
4. Загрузить аппаратную конфигурацию в контроллер.
5. Провести диагностику работоспособности системы.
6. Подготовить ответы на контрольные вопросы.
7. Подготовить отчет

[bookmark: _Toc455927640]Аппаратное конфигурирование в HW Config.	Comment by SVizor: Добавлено.
После создания проекта необходимо приступить к конфигурированию аппаратной части системы управления. Для этих целей в SIMATIC PCS 7 используется специальная утилита HW Config. 	Comment by SVizor: Добавлено.
Для запуска HW Config воспользуйтесь соответствующим значком [image: ] в разделе AS станции. В открывшемся окне отобразится структура оборудования системы, включающая на данный момент только стойку контроллера с соответствующим набором модулей.	Comment by SVizor: Добавлено.
Теперь аппаратную конфигурацию необходимо дополнить элементами корзины распределенной периферии, включающей в свой состав интерфейсный модуль и ряд сигнальных модулей. Начинать конфигурирование необходимо с интерфейсного модуля ET–200М. Для этого в каталоге оборудования, расположенном в правой части текущего окна (рис. 9), следует выбрать соответствующий модуль. Либо воспользоваться строкой поиска, введя серийный номер элемента 153-2BA02-0XB0. Затем необходимо поместить этот модуль на шину PROFIBUS DP(1).	Comment by SVizor: Исправлено.

[image: ]
Рис. 9. Главное окно HW Config.

Следующий шаг – добавление сигнальных модулей в корзину распределенной периферии, производится аналогичным образом: нужно найти необходимый модуль в каталоге и добавить его в соответствующий слот корзины. На рис. 10 представлена полностью сконфигурированная корзина распределенной периферии данного лабораторного комплекса.	Comment by SVizor: Не ИМ, а СМ!	Comment by SVizor: Исправлено.
Настроить тип сигнала можно в свойствах (Properties) модуля во вкладке входных/выходных сигналов (Inputs/Outputs). На всех активных каналах аналоговых модулей ввода/вывода следует указать унифицированный токовый сигнал (I) 4–20 мA (рис 11).	Comment by SVizor: Исправлено.

[image: ]	Comment by SVizor: Исправлено.
Рис. 10. Сконфигурированная корзина распределенной периферии.	Comment by SVizor: Исправлено.
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Рис. 11. Конфигурирование каналов входного аналогового модуля.	Comment by SVizor: Исправлено.
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Рис. 12. Утилита SIMATIC NET Configuration Console.

Перед загрузкой аппаратной конфигурации необходимо настроить коммуникации между станцией автоматизации (AS) и станцией инженера (ES). Для этого воспользуемся консолью для конфигурации (Configuration Console), входящей в состав утилиты SIMATIC NET (рис. 12). Запустить консоль можно из окна SIMATIC Manager или при помощи пункта меню Windows (Пуск > SIMATIC > SIMATIC NET > Configuration Console). В открывшемся окне, в разделе Access points, указывается точка доступа, через которую будет производиться обмен данными. В нашем случае выбираем PC internal (local) – это означает, что будет использоваться точка доступа, указанная в Station configuration editor, т.е. Industrial Ethernet.	Comment by SVizor: Fixed.
После этого следует произвести компиляцию [image: ] и загрузку [image: ] аппаратной конфигурации в контроллер, воспользовавшись соответствующими пиктограммами на панели инструментов. В процессе загрузки откроется диалоговое окно, в котором необходимо будет указать имеющийся контроллер. По окончанию загрузки конфигурации светодиодные индикаторы должны светиться зеленым цветом, что означает, что процесс загрузки выполнен успешно. В случае возникновения неполадок следует проверить правильность заданного MAC-адреса контроллера, который указан на его корпусе.	Comment by SVizor: Исправ.	Comment by SVizor: Исправлено.

[bookmark: _Toc455927641]Контрольные вопросы
1. Каково основное назначение утилиты HW Config?
2. Какие типы модули ввода/вывода используются в данном лабораторном комплексе?
3. Каким образом конфигурируются каналы модулей ввода/вывода?	Comment by SVizor: Добавлено и исправлено.
4. Каково основное назначение конфигурационной консоли утилиты SIMATIC Net?
5. Каким образом конфигурируется точка доступа в текущем проекте?


[bookmark: _Toc455927642]ЛАБОРАТОРНАЯ РАБОТА №4. Конфигурирование аппаратных средств. Интеллектуальные полевые устройства с PROFIBUS-DP/PA.

Цель работы: Сконфигурировать в среде разработки SIMATIC PCS 7 полевые устройства, осуществляющие передачу данных по цифровой шине PROFIBUS-DP/PA.

[bookmark: _Toc455927643]Содержание работы:
1. Сконфигурировать цифровые сети PROFIBUS-DP/PA.
2. Сконфигурировать кориолисовые расходомеры, датчики температуры и давления, подключенные к цифровой сети PROFIBUS-PA.
3. Загрузить аппаратную конфигурацию в контроллер.
4. Произвести настройку датчиков, используя программный пакет SIMATIC PDM.
5. Подготовить ответы на контрольные вопросы.
6. Подготовить отчет.

[bookmark: _Toc455927644]Конфигурирование интеллектуальных полевых устройств по шине PROFIBUS-DP/PA.	Comment by SVizor: Правлено.
В первую очередь аппаратную конфигурацию необходимо дополнить следующими компонентами: 
1) Интерфейсным модулем IM 153-2 для подключения станции ET 200M к сети PROFIBUS DP с электрическими (RS 485) каналами связи и выполнения функций стандартного ведомого устройства.	Comment by SVizor: Исправл.
2) Модулем FDC 157-0, который служит преобразователем PROFIBUS-DP в PROFIBUS-PA (протокол, используемый в тех случаях, когда имеются особые требования к безопасности, например, во взрывоопасных зонах).
Порядок действий по добавлению данных элементов в конфигурацию системы аналогичен добавлению сигнальных модулей в лабораторной работе №3: по указанному серийному номеру выполняется поиск устройства в каталоге аппаратного обеспечения, и затем найденный прибор «перетаскивается» на шину PROFIBUS-DP. При этом у каждого элемента задается адрес устройства на шине (рис. 14). Для IM 153-2 и FDC 157-0 – это адреса 5 и 6, соответственно.	Comment by SVizor: Исправлено.
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Рис. 13. Сконфигурированная PROFIBUS-DP/PA сеть и приборы.

В случае отсутствия нужных приборов в каталоге аппаратного обеспечения HW Config, необходимо добавить электронное описание соответствующих устройств. Добавление файлов электронного описания приборов (EDD-файлов) производится с помощью утилиты Device Integration Manager пакета SIMATIC PDM, запустить который можно через меню Windows (Пуск > SIMATIC PDM).	Comment by SVizor: Исправлено.
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Рис. 14. Окно настройки адреса и подсети PROFIBUS-PA.
Пакет SIMATIC PDM включает в свой состав набор инструментальных средств, позволяющих производить конфигурирование широкого спектра интеллектуальных устройств полевого уровня различных производителей. SIMATIC PDM поставляется в двух вариантах: в виде самостоятельного пакета, работающего под управлением ОС Windows, либо в виде опционального инструментального средства, интегрируемого в среду STEP 7. Второй вариант позволяет включать пакет SIMATIC PDM в состав среды разработки SIMATIC PCS 7. SIMATIC PDM поддерживает функции маршрутизации, что позволяет устанавливать его на инженерную станцию и обеспечивать связь со всеми сетевыми устройствами полевого уровня.	Comment by SVizor: Исправлено.
Для добавления описания нового прибора в появившимся окне Device Integration Manager следует выбрать пункт главного меню File > Read device from source directory (рис. 15) и указать директорию, где хранятся конфигурационные файлы нужного прибора (например, датчика избыточного давления SITRANS P DS III на рис. 16). Для интеграции прибора в проект следует воспользоваться соответствующей пиктограммой.	Comment by SVizor: Исправлено.
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Рис. 15. Device Integration Manager.

[image: ]Рис. 16. Проводник для выбора конфигурационных файлов.
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Рис. 17. Интегрированный в SIMATIC PDM прибор.
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Рис. 18. Окно выбора модели прибора.

В конфигурацию следует добавить: термопреобразователь SITRANS TH400 PA, расходомеры SITRANS F C MASSFLO MASS 6000 (2 шт.) и датчик давления SITRANS P DS III.	Comment by Stepan: Исправл.
Для начала настройки прибора в SIMATIC PDM достаточно щелкнуть 2 раза на его пиктограмме (рис. 18). При первом запуске потребуется уточнить модель прибора: в некоторых случаях достаточно воспользоваться функцией автоопределения (Device identification), в оставшихся – это необходимо сделать вручную.	Comment by Stepan: Исправл.
На рис. 19 представлен интерфейс SIMATIC PDM с открытой конфигурацией SITRANS TH400 PA. Интерфейс программы позволяет произвести тонкую настройку прибора: указать единицы и диапазон измерений и сигнализации, выполнить настройку нуля, выбрать язык отображения информации. Вам предлагается самостоятельно изучить и разобраться с возможностями SIMATIC PDM, настроить и выполнить загрузку новой конфигурации в прибор (Load to device).	Comment by SVizor: Исправлено.
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Рис. 19. Интерфейс SIMATIC PDM.

[image: ]
Рис. 20. Загрузка конфигурации из SIMATIC PDM
в прибор SITRANS TH400 PA.
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Рис. 21. Дополнительная настройка SITRANS F C MASSFLO MASS 6000.

SITRANS F C MASSFLO MASS 6000 потребует дополнительной настройки. Поскольку это многопараметрический прибор, который помимо непосредственно массового расхода измеряет ряд дополнительных параметров, необходимо будет явно указать требуемые величины, установив их в соответствующие слоты (рис. 21).	Comment by Stepan: Добавил.

[bookmark: _Toc455927645]Контрольные вопросы
1. Каков порядок добавления прибора на шину PROFIBUS-PA?
2. Какие приборы подключались по шине PROFIBUS-PA и использовались при создании данного проекта?
3. Перечислите основные функции пакета SIMATIC PDM.	Comment by Stepan: Добавлено.
4. Какие параметры Вы изменяли у приборов в ходе их настройки через SIMATIC PDM?


[bookmark: _Toc455927646]ЛАБОРАТОРНАЯ РАБОТА №5. Конфигурирование станций и сети.

Цель работы: Произвести конфигурирование станции оператора и установить соединение с аппаратной частью.	Comment by Stepan: Правлено.

[bookmark: _Toc455927647]Содержание работы:
1. Сконфигурировать операторскую станцию в HW Config.
2. Осуществить загрузку станции оператора (OS).
3. Ознакомиться с утилитой NetPro.
4. Установить соединение операторской станции с контроллером.
5. Подготовить ответы на контрольные вопросы.
6. Подготовить отчет.

В данной работе приводится описание того, как нужно конфигурировать однопользовательскую OS при разработке проекта, чтобы она могла проводить коммуникации с системой автоматизации.	Comment by Stepan: Исправл.
Настройка OS коммуникации начинается с запуска Configuration Console через главное меню Windows (Пуск > SIMATIC > SIMATIC NET > Configuration Console). 	Comment by Stepan: Испавлено.
В первую очередь необходимо выбрать режим работы сетевой карты (рис. 22) и уточнить ее MAC-адрес (рис. 23). Для всех сетевых карт имеется два режима работы: PG operation и Configured mode.	Comment by Stepan: Добавлено.

Таблица 1 – Режимы работы сетевых карт.
	Режим работы
	Описание

	Configured mode
	В этом режиме все параметры модуля будут устанавливаться в одном проекте и оттуда передаваться в модуль

	PG operation
	В этом режиме сетевые параметры модуля, такие как адрес станции и скорость передачи, устанавливаются с помощью конфигурационных инструментов Configuration Console или Set PG/PC Interface



[image: ]Рис. 22. Выбор режима работы сетевой карты.	Comment by Stepan: Исправл.
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Рис. 23. Определение МАС-адреса сетевого устройства.	Comment by Stepan: Добавил.

Ассистент создания проекта ('New Project Wizard) автоматически добавляет PC-станцию в Ваш проект на этапе его создания. Если рядом с символом станции отображается желтая стрелка, то это означает, что:	Comment by Stepan: Исправл.
· Имя совпадает с именем компьютера и с именем станции в Station Configurator.
· Точке доступа S7ONLINE назначен параметр “PC internal (local)”.
Конфигурирование станции производится в среде HW Config. После запуска HW Config, в открывшемся окне отобразится структура конфигурации PC-станции. В слоте 2 уже находится объект WinCC Application, как связующее звено между сетевой картой и собственно OS-проектом. Вам необходимо добавить в слот 1 сетевую карту, используемую на инженерной станции, из списка стандартного оборудования, размещенного в правой части окна. В Вашем случае это IE General (т.е. любая сетевая карта не от компании SIEMENS).	Comment by SVizor: Добавлено.

[image: ]
Рис. 24. Конфигурирование компонентов PC-станции.	Comment by Stepan: Исправл.

Теперь необходимо открыть свойства сетевой карты и произвести настройку параметров сетевого соединения между AS и OS (рис. 25). Следует отключить использование IP протокола и указать корректный MAC адрес.

[image: ]
Рис. 25. Параметры сетевой карты.

Скомпилируйте и сохраните конфигурацию OS-станции (Station > Save and Compile).	Comment by Stepan: +
Для завершения конфигурирования вернитесь в окно SIMATIC Manager. Выделите PC-станцию, ПКМ вызовите контекстное меню и выберите пункт PLC > Configure… В открывшемся диалоговом окне Configure доступны все OS станции.	Comment by Stepan: +
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Рис. 26. Конфигурирование целевого компьютера.
	Comment by Stepan: +
Выделите требуемый целевой компьютер из списка доступных (Accessible computers). В случае однопользовательской системы Вам доступна только собственная станция. Щелкните по кнопке Configure…
[bookmark: _Toc59765733][bookmark: _Toc186204599]Теперь следует произвести конфигурирование коммуникаций AS-OS в среде NetPro. Запустить NetPro можно из окна SIMATIC Manager (Options > Configure Network) или воспользовавшись соответствующим значком  [image: ] .	Comment by Stepan: +
В NetPro в графическом виде представлены все связи между компонентами системы (рис. 27). В качестве следующего шага Вы можете задать системе автоматизации сетевой адрес и соединить ее с шиной предприятия. Эти установки можно выполнять как с помощью HW Config, так и с помощью NetPro.
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Рис. 27. Интерфейс NetPro.

В NetPro в составе AS выделите объект CPU 414-3 DP, который должен быть соединен с шиной предприятия, и откройте его свойства. В открывшемся диалоге, как и в аналогичном окне для сетевой карты, определите протокол на шине предприятия и сетевой MAC адрес. В качестве шины предприятия выберите Ethernet(1).
Так же в NetPro необходимо создать логическое соединение с типом «S7 connection» между станциями (рис. 28). Для этого в составе РС-станции выделите объект WinCC Appl. [1] и через контекстное меню добавьте новое соединение (Insert new connection). В появившемся диалоговом окне выберите нужную AS.	Comment by Stepan: +

[image: ]
[bookmark: _Toc186204600]Рис. 28. Конфигурирование S7 соединения между AS и OS.
Вы можете заметить, что некоторые станции в NetPro окрашены в оранжевый цвет. Этот говорит о том, что конфигурация станции была изменена. Выполните компиляцию конфигурации (Save and Compile). После этого ее цвет станет белым, если компиляция прошла без ошибок, или красным – в противном случае.
После того, как сконфигурированы все соединения, необходимо произвести загрузку OS станции. Выделите нужную станцию и нажмите PLC > Download to Current Project > Selected Stations, либо воспользуйтесь соответствующим значком на панели инструментов.
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Рис. 29. Загрузка конфигурации.

[bookmark: _Toc455927648]Контрольные вопросы
1. Каковы основные этапы конфигурирования OS станции?
2. Какие существуют режимы работы сетевых карт?
3. Для чего предназначено приложение NetPro?


[bookmark: _Toc455927649]ЛАБОРАТОРНАЯ РАБОТА №6. Реализация базовых алгоритмов управления.

Цель работы: Реализовать логику работы системы управления установкой в редакторах CFC-схем.	Comment by Stepan: +

[bookmark: _Toc455927650]Содержание работы:
1. Ознакомиться с редактором CFC-схем.
2. Ознакомиться с блоками и шаблонами стандартной библиотеки APL.
3. Реализовать контуры ПИД-регулирования и индикации основных управляемых величин.
4. Выполнить загрузку программы в контроллер.
5. Подготовить ответы на контрольные вопросы.
6. Подготовить отчет.

Advanced Process Library (APL) является стандартной библиотекой PCS 7, которая разработана специально для автоматизации непрерывных процессов. Перед началом создания базовых алгоритмов контроля и управления установки, рекомендуется добавить часто используемые шаблоны функциональных блоков из APL в собственную библиотеку проекта. В Вашем случае подобной библиотекой будет выступать Lab210-Lib, которая была добавлена на этапе создания проекта. Данная библиотека будет содержать все необходимые шаблоны функциональных блоков.	Comment by Stepan: +

[image: ]
Рис. 30. Перенос шаблонов из PCS 7 APL в собственную библиотеку проекта.
Откройте существующую библиотеку проекта Lab210-Lib (File > Open > Libraries > Lab210-Lib). Cкопируете из APL шаблоны AnalogMonitoring и AnalogMonitoring_fb (fb от Fieldbus), которые содержат уже готовые блоки с алгоритмами контроля и индикации.
Важно отметить, что все дальнейшие действия по редактированию блоков следует проводить в режиме Plant View.	Comment by Stepan: +
Откройте шаблон AnalogMonitoring в редакторе CFC-схем. Данный шаблон состоит из 2 блоков и предназначен для контроля аналоговой переменной процесса при помощи модуля MonAnL.	Comment by Stepan: +
Аналоговое значение вводится через модуль PCS7AnIn из периферии. На вход PV_In подается измеренное значение аналогового сигнала. Параметры Scale и PV_InUnit предназначены для настройки шкалы и единиц измерения параметра, соответственно. Код той или иной единицы измерения можно найти в документации.
Измеренное и преобразованное значение параметра поступает на вход PV блока MonAnL, который служит связью между контроллером и SCADA-системой. Данные из этого блока преобразуются в теги, которые будут отображаться на станции оператора.
Устройство блока AnalogMonitoring_fb аналогично предыдущему шаблону, за тем исключением, что у данного блока есть дополнительный вход для проверки состояния качества сигнала PROFIBUS-PA приборов.
Для удобства разработки рекомендуется предварительно отредактировать таблицу символов, сопоставив в ней каждому физическому адресу модуля ввода/вывода символьное имя. Таблицу можно редактировать в HW Config, вызвав пункт контекстного меню Edit > Symbols для конкретного модуля, или непосредственно открыть Symbol Table в SIMATIC Manager. Вам необходимо заполнить таблицу символов в своем проекте, придерживаясь образца (Приложении 1).	Comment by Stepan: +
После заполнения таблицы скопируйте шаблон AnalogMonitoring к себе в проект и переименуйте его в TI2. Откройте и отредактируйте полученный блок:	Comment by Stepan: +
1) Задайте имена модулям PCS7AnIn и MonAnL в соответствии с рис. 29;
2) Свяжите вход PV_In модуля PCS7AnIn с символьным именем TI_2_TEMP (ПКМ > Interconnection to address).
3) Задайте для параметра Scale диапазон измерения от 0 до 100, а в качестве единиц измерения – градус Цельсия (PV_InUnit = 1001).

[image: ]
Рис. 31. Сконфигурированный блок контроля температуры TI2.

Компиляция и загрузка программы проводится аналогично HW Config. Для проверки работы блока следует воспользоваться разделом главного меню Test. 
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Рис. 32. Компиляция программы.

В соответствии с вышеописанной процедурой для TI2 создаются блоки мониторинга для следующих параметров:	Comment by Stepan: +
1) TI1 – TI9 – модули контроля температуры по высоте колонны;
2) PDI – модуль контроля перепада давления по высоте колонны;
3) PI1 – модуль контроля давления верха колонны;
4) LI14 – модуль контроля уровня воды в кипятильнике;
5) LI13 – модуль контроля уровня воды в кубе колонны;
6) LI15 – модуль контроля уровня жидкости во флегмовой ёмкости.
Для реализации алгоритмов управления воспользуемся шаблонами StepControlActor и StepControlActor_fb (рис. 33). Прежде всего, перенесем указанные шаблоны в библиотеку проекта Lab210-Lib. Шаблоны практически готовы к использованию. При создании конкретного контура регулирования, необходимо лишь корректно соотнести следующие входы/выходы блоков с физическими адресами или символьными именами из таблицы символов:	Comment by Stepan: +	Comment by Stepan: +
· вход PV блока PV – управляемая физическая величина;	Comment by Stepan: Правка.
· вход PV_In блока MV_Rbk – обратная связь регулирующего органа;
· вход PV_In блока FbkClosed – сигнал от концевого выключателя, положение "Закрыто";
· вход PV_In блока FbkOpened – сигнал от концевого выключателя, положение "Открыто";
· выход PV_Out блока СommandClose! – управляющий сигнал "Закрыть";
· выход PV_Out блока СommandOpen! – управляющий сигнал "Открыть".
Более подробную информацию о данном шаблоне можно найти в технической документации [5].
На рис. 33 приведен пример сконфигурированного блока регулирования подачи питания в колонну FIC12.	Comment by Stepan: +

[image: ]
Рис. 33. Сконфигурированный контур управления FIC12.	Comment by Stepan: Исправл.
Аналогичным образом создаются контуры регулирования FIC11 и FIC17, с последующий загрузкой обновленной конфигурации в контроллер.

[image: ]
Рис. 34. Сконфигурированный блок управления нагревом куба колонны.	Comment by Stepan: +

В основе алгоритма блока управления нагревом куба колонны будет заложен принцип двухпозиционного регулирования. Для реализации данного алгоритма Вам понадобятся следующие блоки:
· блоки преобразования типов данных, расположенные в следующей последовательности RealToDw > DwToW > WToInt;
· 2 компаратора (в зависимости от результата сравнения на данных блоках, активным становится только один из входов триггера);
· блок RS-триггера;
· драйвер-блок выходного дискретного параметра PCS7DiOu.	Comment by Stepan: +
Найдите данные блоки в стандартной библиотеке шаблонов и сконфигурируйте их так, как показано на рис. 34.
Кроме того, для передачи параметров на уровень визуализации, дополнительно Вам потребуются блоки MonAnS (для температуры куба) и MonDiS (для отображения состояния ТЭНа).	Comment by Stepan: +
В качестве регулирующего органа в данном контуре выступает ТЭН, который может находиться в одном из двух возможных состояний: включенном или выключенном. Когда температура опускается ниже заданного предела, на вход S поступает 1, RS-триггера устанавливается в единичное состояние и ТЭН включается. И наоборот, если температура превысит верхний предел, на вход R поступает 1, триггер сбрасывается в нулевое состояние и ТЭН отключается.
По аналогичному принципу строится и работает контур управления насосом.

[bookmark: _Toc455927651]Контрольные вопросы
1. Что представляет собой APL PCS 7?	Comment by Stepan: +
2. В каких случаях применимы стандартные шаблоны AnalogMonitoring и AnalogMonitoring_fb?
3. Для каких параметров были созданы контуры контроля в данной работе?
4. Для каких параметров были созданы контуры управления в данной работе?
5. Перечислите основные параметры шаблонного регулятора StepControlActor.
6. Расскажите о реализации блока управления нагревом куба колонны.


[bookmark: _Toc455927652]ЛАБОРАТОРНАЯ РАБОТА №7. Разработка визуализации процесса в WinCC.

Цель работы: Реализовать человеко-машинный интерфейс (визуализацию) для имеющегося проекта.

[bookmark: _Toc455927653]Содержание работы:
1. Ознакомиться c инструментом создания визуализации техпроцесса Graphics Designer пакета WinCC.
2. Спроектировать мнемосхему процесса.
3. Установить связь с программными блоками.
4. Произвести проверку работоспособности системы визуализации.
5. Подготовить ответы на контрольные вопросы.
6. Подготовить отчет.

Пакет WinCC, входящий в состав SIMATIC PCS 7, содержит множество различных утилит. Основным инструментом построения человеко-машинного интерфейса (HMI) в WinCC является Graphics Designer.	Comment by Stepan: Edited.
Graphics Designer – это редактор, предоставляющий пользователю различные инструменты и объекты для создания визуально интерфейса оператора. Разработка интерфейса оператора во многом аналогична работе в других подобных графических редакторах.
Для того чтобы приступить к созданию HMI в SIMATIC PCS 7, необходимо:
1) Перейти в SIMATIC Manager в режим Plant View (View > Plant View). В дереве объектов процесса необходимо выбрать элемент Process Cell(1) (раздел, содержащий функциональные блоки), открыть его свойства и убедиться, что в разделе AS/OS Assignment станции AS и OS связаны между собой. Это позволит компилятору самостоятельно преобразовать переменные, приходящие с полевого уровня, в теги, которые отображаются на верхнем уровне HMI.	Comment by Stepan: Edited.
2) В разделе S7 Program(1)\Charts необходимо создать объект типа Picture, в котором будет храниться мнемосхема объекта.
3) После этого достаточно вызвать функцию Options > 'Compile Multiple OSs' Wizard > Start… (рис. 35). Компилятор станции оператора автоматически создаст теги, которые будут отображаться в HMI (рис. 36 - 40).	Comment by Stepan: +
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Рис. 35. Вызов 'Compile Multiple OSs' Wizard.	Comment by Stepan: +
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Рис. 36. Мастер компиляции OS. Шаг 1.
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Рис. 37. Мастер компиляции OS. Шаг 2.
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Рис. 38. Мастер компиляции OS. Шаг 3.
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Рис. 39. Мастер компиляции OS. Шаг 4.
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Рис. 40. Мастер компиляции OS. Шаг 5.
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Рис. 41. Процесс компиляции OS.

4) Если в процессе компиляции не возникло ошибок, то следует запустить WinCC Explorer, который является основной компонентой системы SIMATIC WinCC. В разделе Graphics Designer необходимо найти и открыть ранее созданный Picture-объект. В открывшемся окне остается нарисовать мнемосхему, воспользовавшись доступным инструментарием.	Comment by Stepan: +
Базовыми элементами рисования в WinCC являются различные геометрические примитивы (линии, полигоны, прямоугольники, овалы, круги) и набор различных изображений типовых промышленных машин и аппаратов. Необходимость в создании динамических Faceplates (элементы управления процессом) отсутствует, поскольку они были сгенерированы автоматически на этапе компиляции станции оператора.	Comment by Stepan: +
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Рис. 42. Интерфейс Graphics Designer.
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Рис. 43. Библиотека графических элементов.
[image: ]
Рис. 44. Окончательный вариант интерфейса оператора 
(в режиме редактирования).

Окончательный вид мнемосхемы должен соответствовать рис. 44. По завершению создания мнемосхемы следует запустить HMI приложение, воспользовавшись пунктом меню File > Activate в WinCC Explorer.
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Рис. 45. Окончательный вариант интерфейса оператора
(в режиме исполнения).

В случае появления предупреждающего сообщения (рис. 46) в процессе запуска, следует активировать в настройках проекта пункт Allow Activation On ES (рис. 47), который позволит запускать режим исполнения на инженерной станции.	Comment by Stepan: +
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Рис. 46. Предупреждение о запуске режима исполнения на ES станции.
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[bookmark: _Toc455927654]Рис. 47. Включение режима исполнения на ES станции.


Контрольные вопросы
1. Каково основное назначение пакета SIMATIC WinCC?
2. В каком редакторе производится непосредственное создание мнемосхемы техпроцесса?	Comment by Stepan: +
3. Какие этапы включает в себя создание человеко-машинного интерфейса (HMI) в системе SIMATIC PCS 7?
4. Каким образом осуществляется переход в режим исполнения в SIMATIC WinCC?	Comment by Stepan: 
[bookmark: _Toc455927655]
ЛАБОРАТОРНАЯ РАБОТА №8. Настройка операторской станции.

Цель работы: Произвести настройку архивации сообщений, представления трендов и таблиц на станции оператора (OS).

[bookmark: _Toc455927656]Содержание работы:
1. Изучить возможность создания и настройки трендов.
2. Произвести настройку ПИД-регуляторов.
3. Изучить возможность создания динамических свойств объектов.
4. Подготовить ответы на контрольные вопросы.
5. Подготовить отчет.

[bookmark: _Toc455927657]Создание трендов.
Для создания онлайн трендов технологического процесса необходимо:
1. Находясь в режиме исполнения SIMATIC WinCC, нажать на пиктограмму [image: ] .
2. Создать новую группу трендов и задать ей имя.
3. Выбрать ветку WinCC Tags > SIMATIC S7 Protocol Suite > Named Connections > S7$Program(1).	Comment by Stepan: +
4. Выбрать интересующий параметр.	Comment by SVizor: +
5. Найти тег PV#Value.
6. Задать параметры тренда (например, имя, частоту обновления и т.д.).
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Рис. 48. Окно добавления нового тренда.
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Рис. 49. Окно создания новой группы трендов.
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Рис. 50. Настройка параметров тренда.
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Рис. 51. Активный тренд.
[bookmark: _Toc455927658]Настройка ПИД-регуляторов.
Типовой ПИД-регулятор в SIMATIC PCS 7 имеет следующие настройки:
1.	Настройка пределов для параметров технологического процесса. Сюда относятся не только диапазоны изменения для физических величин, но и для параметров обратной связи, уставок, гистерезиса и т.д. Их значения следует выбирать исходя из особенностей и регламента технологического процесса.	Comment by SVizor: +
2.	Настройка значения уставок.
3.	Настройка коэффициентов ПИД-регулятора, а так же, в случае цифровых регуляторов, времени срабатывания исполнительного механизма, времени 'пульсации' в миллисекундах. Более подробную информацию можно найти в фирменном руководстве SIMATIC PCS 7.	Comment by SVizor: Исправл.
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Рис. 52. Настройка предельных значений параметров для ТП.
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Рис. 53. Настройка уставки.
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Рис. 54. Настройка параметров ПИД регулятора.
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Рис. 55. Создания визуального элемента ТЭНа.

[bookmark: _Toc455927659]Создание динамических свойств объектов.	Comment by Stepan: Fixed.
Для изучения данной возможности WinCC следует:
1.	Создать элемент, схематично изображающий ТЭН. Для этого необходимо воспользоваться элементом Polyline (Polytube) (рис. 55).
2.	Зайти в свойства нового объекта.
3.	Найти пункт Color line в разделе Colors.
4.	Выбрать опцию Dynamic dialog в столбце Dynamic.
5.	Задать свойства в соответствии с рис. 56:
a) определить переменную/формулу, в зависимости от которой объект будет менять свой цвет;	Comment by Stepan: Исправл.
б) указать логический тип данных (Boolean);
в) задать цвета, которые будет принимать объект, в зависимости от значений переменной (Истина и Ложь, соответственно.	Comment by Stepan: +
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Рис. 56. Привязка тега к свойству объекта.

[image: ]
Рис. 57. Выбор тега для привязки.
[bookmark: _Toc455927660]Контрольные вопросы
1. Как создать онлайн тренд в SIMATIC WinCC?
2. Перечислите параметры ПИД-регулятора, которые подлежат настройке.
3. Каким образом можно настроить динамическое свойство объекта в SIMATIC WinCC?


[bookmark: _Toc455927661]ЛАБОРАТОРНАЯ РАБОТА №9. Алгоритм автоматизированного пуска установки.

Цель работы: Реализовать алгоритм автоматизированного пуска лабораторной установки на языке SFC.

[bookmark: _Toc455927662]Содержание работы:
1. Ознакомиться с редактором SFC-схем.
2. Ознакомиться с алгоритмом автоматизированного пуска установки.
3. Реализовать предложенный алгоритм автоматизированного пуска.
4. Произвести тестовый пуск установки.
5. Подготовить ответы на контрольные вопросы.
6. Подготовить отчет.

[image: ]
Рис. 58. Редактор SFC-схем.

Язык Sequential Function Chart (последовательные функциональные схемы) – это графический язык программирования для последовательного управления технологическим процессом. При разработке в качестве основных единиц используются блоки состояний Step (Шаг) и логические переходы между ними Transition (Переход).
В блоке Step выполняются действия, которые задает разработчик, (например, открытие клапана, включение насоса и т.д.). Переход к следующему блоку осуществляется после того, как выполнятся все условия в блоке Transition. Задание действий и условий переходов происходит путем установки значений входных переменных CFC-блоков.
Алгоритм автоматизированного пуска лабораторной установки включает в себя следующие шаги:
1.	Произвести закрытие всех регулирующих клапанов, независимо от их текущего состояния; удостовериться, что все контуры регулирования находятся в ручном режиме управления.
2.	Открыть клапан, отвечающий за подачу питания.
3.	Набрать определенный уровень в кубе колонны 10.
4.	Закрыть клапан на подаче питания.
5.	Приступить к нагреву установки, включив в работу ТЭН 19, расположенный в кубе колонны 10.
6.	После достижения температуры в кубе колонны 100 °C, контур регулирования температуры перевести в автоматический режим.
7.	Открыть регулирующий клапан 17 и подать воду в межтрубное пространство дефлегматора 11.
8.	При появлении уровня во флегмовой емкости 12, включить в работу насос 7; контур регулирования расхода воды в дефлегматор перевести в автоматический режим.
Для реализации данного алгоритма необходимо выполнить следующие действия:
1) Переключитесь в режим Plant View.
2) Добавьте в проект SFC-схему (PLC > Insert New Object > SFC).
3) Откройте SFC-схему в редакторе.
4) Откройте свойства блока состояния START.
5) Произведите закрытие всех регулирующих клапанов. Для этого во вкладке Processing нажать кнопку Browse, найти параметр Process Cell(1)\Unit(1)\Function(1)\\FIC12\Valve.CloseMan и установить его значение 1 (True). Аналогичным образом выбрать параметр OpenMan, и установить его значение 0 (False). Это приведет к закрытию клапана на подаче питания во время работы алгоритма.
6) Для клапанов FIC11 и FIC17 повторите пункт 5.
7) Переименуйте блок условия перехода 1 в isClosed, открыть его свойства, во вкладке Condition нажать кнопку Browse, найти параметр Process Cell(1)\Unit(1)\Function(1)\\FIC12\FbkClosed.PV_In и установить его значение 1 (True).	Comment by Stepan: Исправл.
8) Для клапанов FIC11 и FIC17 повторите пункт 7 (рис. 55).
9) Добавьте новый блок Step + Transition после блока isClosed, воспользовавшись командой меню Insert.
10) Переименуйте добавленный блок состояния в OpenFV12_1. Для открытия клапана на подаче питания установите в свойствах блока параметры следующим образом:	Comment by Stepan: +
FIC12\Valve.CloseMan = 0
FIC12\Valve.OpenMan = 1.
11) Переименуйте добавленное условие перехода в LVBottom. В свойствах условия добавьте проверку значения уровня в кубе колонны:
FIC12\Valve.FbkClose.Value = 0
FIC12\Valve.FbkClose.Value = 1
LI13\Input1.PV_Out.Value > 20.
12) Добавьте новый блок Step + Transition для закрытия клапана на линии подачи питания. Переименуйте блоки в соответствии с рис. 55. Определите перечень действий и условия перехода аналогично пунктам 5 и 7.
13) Создайте блок состояния HeatOn и установите в нем ручной режим работы ТЭНа.
14) Создайте условие перехода TempCondit и пропишите в этом блоке проверку значения температуры куба колонны:
TI3\Input1.PV_Out.Value > 100.
15) Добавьте новый блок Step + Transition для открытия клапана FV17 на линии подачи воды в межтрубное пространство дефлегматора (см. пункт 12). В блоке состояния установите параметр открытия клапана, а в свойствах условия перехода пропишите появление уровня жидкости во флегмовой емкости.
16) Создайте и сконфигурируйте должным образом блок состояния, предназначенный для включения в работу насоса 7. В этом же блоке переведите контур расхода FIC17 в автоматический режим работы:
FIC17\PID.AutModOp = 1
FIC17\PID.ManModOp = 0
FIC17\Valve.AutModOp = 1.
Придерживаясь указанных действий, Вы получите работоспособный алгоритм, реализующий процедуру автоматизированного пуска установки в работу.
Осталось протестировать созданную SFC-диаграмму, произведя пробный пуск установки.
[image: ]
Рис. 59. Окно свойств блока состояния START.	Comment by Stepan: +

[image: ]
Рис. 60. Окно свойств блока условия isClosed.	Comment by Stepan: +

[image: ]
Рис. 61. Выбор переменной.

[image: ]
Рис. 62. SFC-диаграмма автоматизированного пуска.

[bookmark: _Toc455927663]Контрольные вопросы
1. Что представляет собой язык SFC?	Comment by Stepan: +
2. Расскажите о применении языка SFC в данной лабораторной работе?
3. Перечислите основные шаги алгоритма автоматизированного пуска.
4. [bookmark: _Toc455927664]Перечислите основные этапы реализации алгоритма автоматизированного пуска.
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[bookmark: _Toc455927665]Приложение 1

Таблица 1. – Таблица символов контроллера
	Тэг
	Физ. адрес
	Тип

	FIC_11_CLOSE
	Q0.7
	BOOL

	FIC_11_CLOSED
	I0.7
	BOOL

	FIC_11_FB
	IW548
	WORD

	FIC_11_FLOW
	IW558
	WORD

	FIC_11_OPEN
	Q0.6
	BOOL

	FIC_11_OPENED
	I0.6
	BOOL

	FIC_12_CLOSE
	Q0.5
	BOOL

	FIC_12_CLOSED
	I0.5
	BOOL

	FIC_12_DENS
	ID646
	REAL

	FIC_12_DENS_QTY
	IB650
	BYTE

	FIC_12_FB
	IW550
	WORD

	FIC_12_FLOW
	IW556
	WORD

	FIC_12_MASS_FLOW
	ID596
	REAL

	FIC_12_MASS_FLOW_QTY
	IB600
	BYTE

	FIC_12_OPEN
	Q0.4
	BOOL

	FIC_12_OPENED
	I0.4
	BOOL

	FIC_12_TEMP
	ID651
	REAL

	FIC_12_TEMP_QTY
	IB655
	BYTE

	FIC_12_VOLUME_FLOW
	ID641
	REAL

	FIC_12_VOLUME_FLOW_QTY
	IB645
	BYTE

	FIC_17_CLOSE
	Q0.3
	BOOL

	FIC_17_CLOSED
	I0.3
	BOOL

	FIC_17_DENS
	ID626
	REAL

	FIC_17_DENS_QTY
	IB630
	BYTE

	FIC_17_FB
	IW544
	WORD

	FIC_17_MASS_FLOW
	ID581
	REAL

	FIC_17_MASS_FLOW_QTY
	IB585
	BYTE

	FIC_17_OPE
	NQ0.2
	BOOL

	FIC_17_OPENED
	I0.2
	BOOL

	FIC_17_TEMP
	ID631
	REAL

	FIC_17_TEMP_QTY
	IB635
	BYTE

	FIC_17_VOLUME_FLOW
	ID636
	REAL

	FIC_17_VOLUME_FLOW_QTY
	IB640
	BYTE

	FIC_20_CLOSE
	Q0.1
	BOOL

	FIC_20_CLOSED
	I0.1
	BOOL

	FIC_20_FB
	IW546
	WORD

	FIC_20_OPEN
	Q0.0
	BOOL

	FIC_20_OPENED
	I0.0
	BOOL

	LI_13_LEVEL
	IW512
	WORD

	LI_14_LEVEL
	IW566
	WORD

	LI_15_LEVEL
	IW568
	WORD

	PDI_10_PRES_DR
	OP570
	IW

	PI_1_PRES
	ID621
	REAL

	PI_1_PRES_QTY
	IB625
	BYTE

	PUMP_13_CONTROL
	Q2.1
	BOOL

	TI_16_TEMP
	IW564
	WORD

	TI_18_TEMP
	ID611
	REAL

	TI_18_TEMP_QTY
	IB615
	BYTE

	TI_2_TEMP
	IW514
	WORD

	TI_3_TEMP
	IW516
	WORD

	TI_4_TEMP
	IW518
	WORD

	TI_5_TEMP
	IW528
	WORD

	TI_6_TEMP
	IW530
	WORD

	TI_7_TEMP
	IW532
	WORD

	TI_8_TEMP
	IW534
	WORD

	TI_9_TEMP
	IW560
	WORD
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